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Members’ Print Exhibition 2011

The closing date for entries 1s
Thursday 3rd March 2011

Full details and an application form will be available
in the Winter Issue of DIGIT which will be published
in January 2011

23rd January 2011
10:30am - 4:30pm

Midlands DIG Centre - January
Meeting

Smethwick Photographic Society
Clubrooms,

"How to build your own
website" and
"Photographers - their
rights and duties."

Booking essential

For full details see the EVENTS listing on Page 4 or contact
Noel Shaw midic@nsashaw.co.uk or 01789 298386

13th March 2011
10:00am

2011 DI Group Annual General
Meeting and Print Exhibition
Selection

Smethwick Photographic Society
Clubrooms, The Old Schoolhouse,
Churchbridge, Oldbury, West Midlands
B69 2AS

The Annual General Meeting will be
followed by the selection of prints for the
2011 Exhibition. There will be a speaker

during the afternoon, details to follow when
available

For more information contact: Bob Pearson FRPS, email:
secretary(@digit.rps.org
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19th December 2010

Digital Imaging Members’ Day
Merryfield Hall, Ilton, Somerset TA19
IHG

Time: 10:00AM - 4:00PM

Contact: Tony Poole ARPS

Email: tonyfpoole@googlemail.com
Phone: 0117 9565399

Cost: £3.00

Tutorials and Member's work - and
general Christmas jollity!

23rd January 2011

Midlands DI Centre - January
Meeting

Smethwick Photographic Society
Clubrooms, The Old Schoolhouse,
Churchbridge, Oldbury, West
Midlands B69 2AS

Time: 10:30AM - 4:30PM

Contact: Noel Shaw

Email: midic@nsashaw.co.uk

Phone: 01789 298386

First session: "How to build your own
website" by Centre Co-ordinator Andy
Butcher. At the end of the session
members will have their own website up
and running using the Microsoft Office
Live system.

Content:

- Image preparation, sizing, formats and
protecting copyright.

- Site design and layout, adding text and
images to website.

- Creating a slideshow for the website.
Second session: A solicitor will present:
"Photographers - their rights and duties."
Submit your special questions in advance
to Noel Shaw. Latest by 7 January 2011
Full details from http:/www.midig.org
Booking essential with Noel Shaw
midic@nsashaw.co.uk or 01789 298386

13th March 2011

2011 DI Group Annual General
Meeting and Print Exhibition Selection
Smethwick Photographic Society
Clubrooms, The Old Schoolhouse,
Churchbridge, Oldbury, West
Midlands B69 2AS

Time: 10:00AM

Contact: Bob Pearson FRPS

Email: secretary@digit.rps.org

A date for your Diary!

The Annual General Meeting will be
followed by the selection of prints for the
2011 Exhibition. There will be a speaker

EVENTS

during the afternoon, details to follow
when available

Planned Future Centre Events in 2011

Midlands RPS Digital Imaging Centre
For more information please see
http://www.midig.org

Centre meeting are held every two
months on a Sunday. Meetings start
promptly at 10.30am and finish around
4.00pm. With a large membership we are
now operating a 'booking system' for
each meeting with 100 places available
on a 'first-come-first-served basis.

To reserve your place for each meeting
please contact Noel Shaw LRPS by e-
mail: midic@nsashaw.co.uk or
telephone: 01789 298386

20th & 26th March: HDR Location
Shooting Sessions

3rd April 2011: HDR Photography
22nd May 2011: Extended Event - A
Weekend of Photoshop Techniques

17th July 2011: Annual Members' Print
Exhibition Selection Plus, Recovering
Data from Corrupted Memory Cards, etc.
18th September 2011: Digital Pinhole
Photography

20th November 2011: Digital Workshop
Day - Sessions on a Variety of Topics

Thames Valley Centre:

All our meetings start at 10.00am for
10.30, and free tea, coffee and biscuits
are available throughout the day. The
meetings continue into the afternoon, so
you should bring a packed lunch. We
finish around 3.30pm to 4pm. For more
information please see
http://www.rpsdig-thamesvalley.org.uk
30th January 2011: Membership
Presentations. Details to be advised. If
you would like to give a short
presentation, please let Roger Norton
know in advance

20th February 2011: Some from Him
and More from Her, Colin and Chrissie
Westgate. Colin Westgate FRPS is a
well-known landscape photographer both
in colour and Black & White. Chrissie
has recently obtained her FRPS and will
be showing her panel; she is an excellent
portrait photographer. Both Colin and
Chrissie regularly win awards in
exhibitions.

27th March 2011: Morning: Perfect

Pixels: This is a practical demonstration
of techniques to ensure the maximum
quality of your images is maintained
throughout the editing process, covers
use of smart objects, layers, sharpening
methods, tonal adjustments and resizing
etc.

Afternoon: Orang-utan. The
Disappearing Ape, Mike Fuller. This is a
digital presentation and talk based on a
study visit made by Mike and Ursula
Fuller LRPS to witness the work of the
Orang-utan Foundation in Southern
Borneo.

17th April 2011: to be advised

22nd May 2011: Morning: Creative
Photography, Don Byatt ARPS EFIAP
MPAGB BPE4*. A digital talk showing
how to be creative in the camera and
afterwards in the computer.

Afternoon: The Annual Projected
Digital Image Competition.

25th September 2011: A Big Byte of
Barbie and Downtrodden Man, Barbie
Lindsay MPAGB EFIAP and Russell
Lindsay MPAGB AFIAP. A digital talk
showing how to be creative in the
camera and afterwards in the computer.
Barbie says: Rusty and I currently both
work for the same company as digital
imaging specialists. We are using
Photoshop CS on a daily basis to
improve and create perfect pictures out
of sow's ears sometimes. Rusty will
photograph anything if he thinks it will
make a good picture, I will just
photograph anything!

Rusty enjoys taking urban photographs,
creating scenes and taking pictures of
rock bands. I love people, the stranger
the better, but I also love macro work,
moths and insects are a particular
favourite. I enjoy a challenge of which
both of these subjects give me. But
overall we take everything. Ex
darkroom workers, mono and colour,
but now totally digital. Transferring our
skills across back in 1996.

October 2011: to be advised

27th November 2011: Annual General
Meeting, Member Presentations and The
Millennium Cup Competition for Prints

Other Centres

Please contact the appropriate Centre
Coordinator, whose details are given on
Page 3.
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FROM THE CHAIRMAN

the recently published RPS ‘Portfolio

Two’. The book contains a
phenomenal variety of pictures with a
whole range of approaches that illustrate
how we witness and capture the world
about us. The book also underlines the
great breadth of photographic work the
Society embraces, a reminder that there’s
space for everyone to express themselves
by whatever means in the ever-expanding
event-horizon of photography.
This edition of DIGIT includes a range
of expression from DIG members in the
form of the Annual Print Exhibition on
DVD. After several years making
comments upon the images, it was time
for a change of both viewpoint and voice.
In taking over from me, our good friend
and knowledgeable colleague, Robert
Albright FRPS, has done a great job.
Robert’s commentary on the prints offers
valuable insights about their success and
how each image interacts with the
viewer.
In mid-November the RPS ‘Think
Photography 2010’ exhibition took place
at the architecturally stimulating arts
centre, ‘The Public’, in West Bromwich
near Birmingham. The event included
trade displays, lectures, demonstrations,
RPS Licentiateship Distinctions
Assessments, a meeting of the local
(Midlands) DIG Centre, a photo-
competition and displays by the RPS
Specialist Interest Groups. The DI
Group had an excellent display featuring
prints and projected images, DVD’s and
copies of ‘DIGIT’. Our colleagues
manning the stand did a brisk trade with
many enquiries and several people
signing-up to join our Group. This
wouldn’t have been possible without all
the hard work and support by DI
committee members and help from the
membership at large. The occasion also
provided an excellent opportunity to
present the awards for the first DIG
Projected Image Competition. The Award
Winning images, together with all the
other accepted images appear on pages
18 to 42 of this issue of DIGIT.
Photography certainly is a curious

It was wonderful to receive a copy of
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business. What makes certain pictures
work and resonate with an audience,
whilst others, for all their meeting of
expected criteria, fail to communicate or
stimulate the viewer? The reasons for
this failure may be obvious but
frequently such a lack of communication
remains elusive and almost impossible to
define. In this digital age we have more
tools than ever at our disposal with
which to both manage and present better
images and yet, as with any art, a
dialogue must be established between
artist and audience. I’ve discussed this
subject with colleagues, DI Group
members, artists and fellow
photographers and the one word that
appears to sum up what we’re looking
for is ‘sincerity’ — and this perversely, is
also something that’s incredibly difficult
to define. It’s got nothing to do with
sincerity of intent on behalf of the
photographer or to do with the veracity
and provenance of the material or subject
or location. A straight record, a
landscape, a portrait, a surreal image, a
composite image or photo-journalistic
shot can all be equally sincere.

Somehow the viewer needs to be
involved and committed to associate with
the scene. In short, the picture must
transcend any barriers imposed by
equipment, process, ability, or
manipulation.

Let’s take an example: A harbour scene
with a seagull, just in the right spot,
swooping in at or near ‘the golden mean’
(what some people rather inaccurately
refer to as ‘thirds’). This could be
regarded as all-too-perfect by some;
however presenting a shot where the bird
is in the centre or near an edge could
gain the criticism, “it would be better
placed on a third”. I’'m sure that we’ve
all experienced this sort of thing. Why is
this so? Is it that we’re unable to trust
perfection and we can’t believe that
someone has actually waited patiently for
the precise moment? Is it that people
have become suspicious and suspect
some digital devilry? Could it simply be
that people don’t like to think they’ve
been fooled? This latter possibility is
probably closer to the truth. If a picture is

Clive Haynes FRPS

obviously surreal the viewer recognises
a very apparent distortion of reality. If
an artist paints a picture then it’s
understood that, as construction, it’s an
interpretation of reality. However, a
photograph remains condemned by its
very nature to somehow illustrate ‘the
truth” and this is possibly the nub of the
matter. The viewer would like to
believe that sometime, somewhere the
scene existed. The suspicion that it’s
been ‘arranged’, even if it conveys the
same essential truth, doesn’t somehow
quite satisfy the soul nearly as much.
Sometimes to ‘confirm reality’ we need
a little “disturbance in the force’ - just
that little mote of something out of
kilter, almost subliminal, to imply
veracity. Real life isn’t perfect and we
can strive too hard to make our pictures
conform to an ideal. Certainly we can
over-compensate and over-manage an
image to the point where is appears
unnatural and ‘polished’. Even in the
most fantastical and super-real scene,
we need, just as in drama, the theatre or
film, to invite the audience to join us in
the ‘willing suspension of disbelief’, to
enter the realm we offer with their
senses simultaneously alert and
receptive. Digital techniques have
given us the ability to manage image
content and fine-tune tonality to such a
degree that we’re in danger of
advancing one step too far and losing
our audience by causing them to
question that elusive sixth-sense sense
that we can only refer to as ‘sincerity’.
Or is it that we’ve simply become over-
suspicious and forgotten how to trust?
Clive Haynes FRPS

The busy DIG stand at this year's Think
Photography Event



CLIVE HAYNES FRPS

TOPAZ — A GEM OF A SET OF

PLUG-INS

Harley Man. This image has received treatment from a combination of Topaz ‘Adjust 4’ and ‘Detail 2°, both of which are described in this article.

In the Winter 2009/10 issue of ‘DIGIT’, No. 44, pp 11-16,Tony Healy ARPS
described how Topaz ‘Simplify’ offers an excellent alternative to the now
discontinued BuZZ Pro. Clive Haynes has recently explored the range of
Photoshop-friendly plug-ins available from Topaz and he’s very impressed by
the versatility, scope, subtlety and usefulness of what’s on offer. He describes
three of those available.

pace will not permit an exhaustive
S illustration of each Topaz plug-in

or the flexibility of each preset.
This article briefly describes three of the
most immediately popular plug-ins
frequently selected by a wide range of
digital photographers. Further
exploration will reveal more task-related
Topaz plug-ins for specific
procedures.The plug-ins from Dallas-
based Topaz Labs are available on-line as
‘downloads’. They install easily and
function efficiently. Once installed,
Topaz Plug-Ins appear as ‘Topaz Labs’ in
the Photoshop Filter menu (Figure 1).
Should you need to contact Topaz, they

are helpful and efficient at answering
queries. At the end of this piece you’ll
find details about how to obtain the
Topaz Plug-ins at a special offer price.
From the onset, it’s apparent that Topaz
Labs have invested a great deal of
thought and development in the design
and workflow of the plug-ins and options
presented. This overview looks at
‘Adjust 4°, ‘Detail 2’ and ‘Simplify’
plug-ins.

Adjust 4.

I’ll begin with ‘Adjust 4°. This plug-in is
incredibly versatile and amongst the
many presets you’ll discover some of the
features to be found in both ‘Detail” and

‘Simplify’. Upon opening, it’s noticeable
that the interface is cleanly presented,;
the layout is logical and easy to
navigate. (Figure 2). ‘Mousing-over’
each preset in the list presents a small
visualisation of its initial effect in the
thumbnail image above the list. To
understand better how some of the
presets perform; I’1l take as a working
example, my image, ‘Portal’, taken in
the charming French hill-top town of
Cordes-sur-Ciel.

From the ‘Adjust 4’ range, I’ve chosen
the preset called ‘Dramatic’. When using
a preset, it’s best to make an initial
adjustment based upon the whole image

RPS DIGIT Magazine Autumn 2010



Figure 1

Figure 3

and then magnify the image as required,
going up to a ratio of 1:1 that is 100%
(actual pixels) to give an accurate
indication of how the preset will be
applied. One of the amazing aspects
about the range of Topaz contrast-
enhancing or detail-revealing presets
(whether represented in Adjust 4, Detail

RPS DIGIT Magazine Autumn 2010

Figure 2

2 or other related plug-ins) is the
incredible amount of information that
the algorithms are able to reveal within
the image — there’s certainly no
immediate fast-acting equivalent in
Photoshop. Another great advantage is
that, unless the adjustment is driven
towards extremes, the halo-effect often

associated with enhancement is
nonexistent or virtually so. In this first
example using ‘Portal’, the image
communicates more effectively by
virtue of the greater sense of presence
and heightened detail, (Figure 3), I made
a copy layer and used Topaz Adjust 4,
‘Drama’ preset, selectively applied using



CLIVE HAYNES FRPS

Figure 4

Figure 5 Figure 6
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Figure 7

a Layer Mask. See: Figure 3, the Topaz
Adjust 4 interface; Figure 4, view at 1:1
(100%); Figure 5, full effect and Figure
6, selective application. As a further
example to illustrate the ‘detail-

Figure 8
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enhancing properties’ of Topaz, two
images, Figures 7 and 8, both at 100%,
show ‘before and after’ application of
the ‘Spicify’ preset in ‘Adjust 4°, at the
default setting.
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CLIVE HAYNES FRPS

Figure 9

Figure 10

Detail 2:

As its name implies, this plug-in features
many presets which specifically address
the structural detail of the image. The
screen-grab, Figure 9, shows the list of
control panel adjustments for ‘Detail 2’.
The microtonal adjustments are very
effective. Figures 10 and 11, ‘before &
after’ (at 100%), illustrate the subtle
enhancement offered by the ‘Micro-
Contrast Color’ preset which principally
addresses the contrast of colour content.
In addition, the retention of highlight
detail is excellent. Having explored one
of the many crispening presets, the next
example goes in a softer direction, using
‘Soft Looking’ from the list of Detail 2
presets. Here, edge definition has been
maintained whilst small details have
become mellow and diffused. See
Figures 12 & 13.

Simplify 2

For those wishing to go softer and more
painterly, then Topaz ‘Simplify 2’ offers a
wide range of interpretations. As an
example, here’s a ‘BuzSim’, full image
and comparative detail. Figure 14 shows
the dialogue box, controls and preview,
Figure 15, the full effect.

As with most filters and presets, the best
working practice is to copy the image
(Background image) and apply the preset

Figure 11

to the copy. Add a Layer Mask and selectively
reveal / hide the preset as required. My image,
‘Harley Man’, has received treatment from a
combination of Topaz ‘Adjust 4” and ‘Detail 2°.
Other Topaz Plug-ins in the series include:
‘Clean’, ‘DeJPEG’, ‘DeNoise’, ‘ReMask’ and
‘InFocus’.

Figure 12
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Figure 13

For further details visit
http://www.topazlabs.com or go to my
website http://www.crhfoto.co.uk
which has ‘before and after’ examples of
Topaz Plug-ins and information on
special offers.

Figure 14
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Figure 15
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ALEX DUFTY LRPS

PHOTOGRAPHS OF THE 2010
MEMBERS’ PRINT EXHIBITION

Prints in the Moors Valley Country Park Reception Area

This year’s Members’ Print Exhibition was held at four venues. Alex Dufty
LRPS, the Group’s Exhibitions Secretary, shows us images from some of the
Exhibitions and briefly describes each venue.

Northlight Gallery, Huddersfield.

This Exhibition of the prints was on for
three weeks and I should like to thank
Phil Hack for looking after the hanging
and stewardship of the Exhibition for the
whole time. The Exhibition was seen by
many of the local general public as well
as many Digital Imaging Group members
who came some distance especially to
see the prints. Unfortunately we do not
have any images of the show, but I gather
from Phil that it looked good.

West Swindon Library, Link Centre.
We have the Exhibition at the library for
the whole of July every year. It is a well-
attended Library and thousands of people
pass through every week. The Library
Staff tell me that it always raises a lot of

12

interest in Digital Photography and the
unusual and creative images that we
show make people realise what can be
done.

I have been there myself when the
visitors come and ask about the
photographers who have created these
images. | am sure this happens at all the
venues but we do seem to get that extra
interest at the Link Centre.

Smethwick Photographic Society, Old
School House, Oldbury.

The Exhibition prints were on display in
the main Lecture Theatre for at least two
weeks and were seen by all the visitors
over that period. I should like to thank
Judith and Roger Parry for all their time
and effort in putting this Exhibition up

and looking after the prints during the
time they were on display.

Moors Valley Country Park, Ashley
Heath, Ringwood.

This Exhibition was in addition to the
original venues, and was shown in the
reception area for a few weeks in
September. Not all the prints were able
to be shown but, in keeping with the
Moors Park theme for the shows, we
selected over 30 prints based on
Landscape and Natural History. I should
like to thank Barry and Fiona Senior,
Carol and Norman Wiles and Ron
Holmes for their help in hanging the
Exhibition at this new venue.
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Norman Wiles LRPS, Fiona Senior FRPS and Barry Senior
Hon FRPS sorting and hanging the selected prints

lan Boulton LRPS and Elizabeth Restall LRPS who helped me
at The Link Centre Swindon

Display at Link Centre Library, Swindon

RPS DIGIT Magazine Autumn 2010

Ron Holmes ARPS making sure the prints are level

The team who helped with the print hanging at Moors Valley
Country Park Reception Area Display. From left to right

Ron Holmes ARPS, Barry Senior Hon FRPS, Fiona Senior
FRPS, Norman Wiles LRPS,Carol Wiles ARPS and Alex Dufty

LRPS

Display at Link Centre Library, Swindon
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DEE WAREHAM

THE DIGIT CHALLENGE

This time we have four images from DIG members who explain how they created them. 1
hope you’ll find these interesting and helpful techniques to use in your own photography. If
you do, why not join in and send some of yours to me at: davidfcookearps@gmail.com.

Pot Pourri

Pot Pourri by Dee Wareham: The
original images were of a bowl of pot
pourri. I took several shots to give me a
wide choice. I then chose the most
interesting for a background. Having
cropped to get rid of the small section of
the bowl and to improve the composition,

Original image for background
14

I decided that the colours were generally
rather dull. I picked several deeper
shades from those within the image and
used a very large brush in Dissolve
mode to add colour. I then used levels to
lighten the background followed by a
significant amount of desaturation.

I used other images for the rectangular
shapes. The larger one is a whole image
which had picked up blue reflections. I
copied this as a layer and transformed to
size. The smaller one is a part of a third
image. I finally put a drop shadow under
both to make them stand out.

Image for one of the small panels
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Figure 1

Flower Fantasy by Carole Lewis
ARPS: I have always enjoyed
photographing flowers. The original
subject of ‘Flower Fantasy’ was a pale
blue convolvulus flower grown from
seed and photographed in my greenhouse
on an early morning in September 2004
using my 105mm macro lens on my
Canon EOS 10D. There was no room
for a tripod so I used ISO 1600 and hand
held the camera. The image sat on my
Mac among my RAW files for many
years before [ worked on it. I like to be
in total control, so I always work on
layers, either on copies of the
background or on adjustment layers.
After cloning minor blemishes and
adjusting the levels, I produced what 1
thought was an interesting but fairly
ordinary detail of the centre of the
flower. (See Figure 1).

So I started to ‘play’ with it in Photoshop
and ended up using Filter>Distort>Twirl
on a merged copy of all the layers (Alt
Key + Layer>Merge Visible) and
renamed it “Twirl’ to remind me what
filter I used. (See Figure 2)

I thought it would look better when the
flower centre was nearer the top right
hand side of the image rather than the
bottom left so I changed it around
(Image>Rotate Canvas> Flip Canvas
Horizontal and then Image>Rotate
Canvas> Flip Canvas Vertical). |
cropped the image slightly at the top and
right hand side to improve the
composition further.

It didn’t look complete so I decided to
add a border; I tried creating various
plain or textured borders but they didn’t
look right. So I increased the canvas size
by 3 cm width and height. I made a copy
of the Twirl layer, applied Gaussian blur
of about 50 pixel radius and transformed
the size (Edit>Free Transform) to fit the
new canvas size. Then I dragged the
layer beneath the Twirl layer. (See
Figure 3)
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Flower Fantasy

It still looked incomplete so I added a
blue coloured Drop Shadow Layer Style
to the Twirl layer. Then I wanted to
darken the flower centre by selecting it,
feathering it and creating a new layer
from the selection to be able to apply the
Multiply Blend Mode. Also I added a
Layer Mask to make fine adjustments by
painting back some areas.

At this point I wanted to sharpen the
image, so I made a merged copy of all
the layers and applied Unsharp Mask at
100/1/0. Although the original flower
was a delicate blue I wanted it to have

Figure 3

CAROLE LEWIS ARPS

more drama: I made a merged copy yet
again and used the Multiply Blend Mode
at 75% to get the final image.

Figure 2
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JEANNE BRADBAN LRPS

Bygone Age: The Final Image

Figure 1

Figure 2

Figure 3
16

Bygone Age by Jeanne Bradban
LRPS:

Figure 1 — original photograph.

* Copy the background layer and
change the opacity on the copy to
58% Normal.

* Add a new layer below the copied
layer and fill it with a warm brown.
T used R221 G 205 B 177 (ddcdbl)
Figure 2 — the coloured layer shows
through the copied layer.

* Apply a gradient map with the
main part of the windmill masked
out. Layer opacity 32% multiply.

* On the Adjustment / Masks
window (Window Adjustment
open) choose soft stripes (black
/white) and check dither box

Figure 3 — showing gradient map

* Add a white to transparent

Figure 4

gradient - tip if you set the colour as
foreground colour on the tool bar
and then open the gradient tool from
the layers window your chosen
colour becomes the gradient colour
to transparent automatically

Figure 4 — showing added gradient

* Select all and copy (layers)
merged followed by paste will
provide a new layer (put at top of
layers list) with work done up to this
point. Should look the same as
Figure 4.

» Using Levels make the layer
approximately 50% lighter

* Duplicate this layer

* Change the top layer of the 2 from
Normal to Multiply. Should look the
same as Figure 4

* Select the layer below and use a
blur filter either Gaussian or Box
radius approx 20

* This will soften the image and
produce the end result (Bygone Age:
the Final Image)
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Flamenco 3 by Ruth Nicholls
LRPS, CPAGB, BPE1*:

I was surprised and flattered when
David asked me to produce this
article about how I created the
Flamenco 3 picture. I think he
probably thought there was a lot of
clever post production
manipulation, to get the shawl
flying out as it does.

However, not so. I took this and
many others at a hotel floor show in
Lanzarote. The dancers were very
professional, the stage and lighting
were abysmal. So I set the camera,
Canon 5D, on motordrive, Auto
White Balance, 1600 ISO, no flash,
hand held, as I had to keep
following the dancer, and hoped for
the best. The lens was 24 -105 L,
Image Stabilised, wide open at F4,
at about 80mm zoom. I had a front
row seat. [ used aperture priority,
and the shutter speed turned out to
be 1/8th sec.

Looking at the original Raw file in
Camera Raw, the colour
temperature turned out to be
3650K, and tint 15 (Figure 1.) My
first adjustments were done in
Camera Raw. I altered the colour
temperature to 2600K, and tint to
12, which was an amazing
improvement. (Figure 2). Next |
adjusted the Camera Raw sliders to
Brightness 65 and Contrast 44. 1
usually use the Clarity sider too, but
as this image was at 1600 ISO, I
didn’t want to risk any increased
noise. (Figure 3).

Now I was happier, so the image
was opened into Photoshop. The
next step was to use the marquee
tool to select the left-hand end of
the curtain, flip it left to right, and
move it to the righthand end of the
image to replace the window. I
converted the background to a
layer, (double click on the word
Background and accept the default
Layer 0, or call it something
useful), and placed the extra curtain
underneath it. Then with a layer
mask on the main image layer
(layer 0), I removed the window by
painting on the mask with black,
and blended in the edges of the
curtain. The bits of the dancer’s
shawl in this new curtain area were
cloned out. And the left curtain
flipped layer was switched off and
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RUTH NICHOLLS LRPS, CPAGB, BPE1*

Flamenco 3: The Final Image

later deleted.

An extra blank layer was made, to
clone onto, to sort out the scratch
on the dancer’s arm, and some stray
lights.

I decided I would like to bring out
more colour in the curtain folds, so
I added a Levels adjustment layer at
the top of the active stack, pushed
the white levels slider inwards until
I was happy with the darker folds
of the curtain, filled the Levels
mask with black, which hides the
adjustment, then carefully painted
over some of the folds of the
curtain with white and a soft edged
brush at varying opacities, to
lighten them. (Figure 4)

Nearly finished. I discarded the top
layer containing the curtain
selection, and flattened the rest of
the image. Then I decided I would
like the white of the shawl to be
whiter, so another Levels
adjustment layer, filled with black
as before, then painted white over

Figure 4

just the solid white parts of the shawl.

I am delighted that this image was

accepted for the DIGIT DPI Exhibition

2010.

Figure 1

Figure 2

Figure 3
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GOLD MEDAL WINNER

MEMBERS’ PROJECTED
IMAGE COMPETITION 2010

‘A Woman and a Man’ by Dr David F Cooke ARPS, Gold Medal Winner

The first Members’ Projected
Image Competition took place in
August this year. There were 358
entries from 120 members. One
hundred and six images were
accepted. From these, each judge
awarded two ribbons, and a gold
medal was awarded to the image
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considered by the judges to be
the best overall entry. We are
extremely grateful to Jack Bates
FRPS, Nick Scott FRPS and
Dave Yates, who gave their time
and expertise to judge the
competition, and to all the
members who entered and helped

to make it a success. The
following pages contain all the

accepted images.

Editor s note: Unfortunately, Nick Scott
FRPS has been unable to provide
comments on the images he gave
awards to so I am extremely grateful to
Robert Albright FRPS for stepping in
and providing his views on the images.
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The Original image

Jack Bates FRPS: We have become well
accustomed to candid pictures of the
girl/boy relationship style, so that even in
the five-second projection this image
could be immediately “understood”. It
was of sufficient general impact to be put
aside for a second look, and it was at that
stage that the greater qualities could be
appreciated. There is perfection in the
placing of the two figures, the framing by
the chairs, the differential focus and the
controlled use of lighting to dramatic
effect; all elements contributing the story
and the impact of its presentation. The
unusual clothing of the woman adds a
level of interesting detail which nicely
compliments the simplicity of the overall
concept.

Robert Albright FRPS: Contrasts: hard
and soft, lace and metal, cream and
black, woman and man. Her gaze,
seemingly at the newspaper, is, in fact,
directed at the mysterious figure in black.
His arm makes a gesture, but to what
intent? Come to me? The handbag waits,
open, voluptuous. Her foot parallels a
line on the floor. The line on the floor
echoes the line of the window; and the
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window leads to him, collar turned up.
Signals, unknown resonances, a certain
proof which discredits the old lie:
photography is the literal art form, the
describer of reality.

Dave Yates: Obviously in every
competition there has to be a winner and
all three judges agreed that ‘A Woman &
A Man’ by David F Cooke was a worthy
one. Personally I felt that it had strong
composition, with a good subject matter
and was well presented.

Dr David F Cooke ARPS: I try hard to
get a sense of a story in my images. Not
to spell it out but to make people wonder
what the story is and let them interpret it
as they will. In this case, I suspect there
isn't any connection between the two
people. It’s a candid shot taken as I was
sitting in a café in Yokohama looking at
the world go by and waiting for photo
opportunities to present themselves. She
was reading the newspaper and he was
someway off telephoning someone.
There were a lot of people doing that
against the windows in the area,
presumably to get a good signal, but I
feel the image does invite the viewer to

DR DAVID F COOKE ARPS

find a connection and make up their
own story.

I created the image first by cropping to
the composition I wanted. I then cloned
out various distractions; the plastic bag
on the chair (which included
reconstructing the chair arm), the object
on the table, some of the reflection on
the floor which I found distracting, and
the pole of a parasol which appeared to
be coming out of the top of her head. |
then used three Nik Filters, Darken
/Lighten Centre (to brighten the image
up), Viveza (to desaturate the foliage in
parts of the background) and Glamour
Glow (which gives the image a slightly
dreamy feel). Finally, the image was
sharpened using the Photoshop High
Pass Filter.

I’'m very pleased to say that, following
its success in this competition, the image
was awarded the FIAP Gold Medal in
the 4th International Photography
Exhibition 'Zajecar 2010' in Serbia. If
you’d like to see more of my images
you can do so on my Facebook page at
http://www.facebook.com/davidfcooke
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RIBBON WINNER. JUDGE: JACK BATES FRPS

CUTTING EDGE

DR BARRY SENIOR HON.FRPS

Ribbon winner. Judge: Jack Bates FRPS

Jack Bates FRPS: This image made an
immediate impact on projection; the use
of just three elements — the cutters, the
wire and the background sheet - arranged
to form a strong graphic design. This
simplicity of concept can be a welcome
relief from the more recent pictures we
see which rely on complex manipulations
for their effect. With additional time to
view the image, the photographic
qualities become very evident, the
carefully balanced side lighting bringing
out the fine textures and subtle colours in
the steel. In my mind, the real subject
here is steel, as shown in the form of the
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wire, the sheet and the tool. Perhaps the
title, “Cutting Edge” fails to help the
viewer to that appreciation.

Dr Barry Senior Hon. FRPS: This
image is one of a series of images of old
tools taken for my Fellowship
submission. It was specifically designed
to be part of the submission but it was
not used because a shot showing all of
the tin snips and a complete circle of
wire was preferred. There is some
artistic license used in the arrangement
because the tin snips are not designed to
be used to cut barbed wire. While it is
possible to find a third dimension to the

interpretation of the image, it was not in
my mind when it was taken!

This image is a studio shot taken with a
Nikon D100 and a Sigma 105 macro
lens using one Elinchrom electronic
flash head and a reflector. The raw file
has been corrected for contrast and a
small amount of sharpening applied. The
set consisted of a home made
background and shelf constructed of
plywood and coated with ‘polyfilla’.
The directional lighting is a consistent
feature of the other images in the
Fellowship submission.
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Ribbon winner. Judge: Jack Bates FRPS

Jack Bates FRPS: Can you smell that
smoke as you look at this picture? It is
quite extraordinary how the photograph
carries the viewer into this scene, as
though he were a participant in the card
game. Technically the challenging
lighting situation has been excellently
handled, and then exploited to add to the
intensity and drawing of the faces and the
atmosphere of the place. But technical
aspects are secondary to the appreciation
of this image. What impresses is that
sense of “being there”, a sense reinforced
by the light, the smell, the smoke and the
pervading tensions of the game.
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RIBBON WINNER. JUDGE: JACK BATES FRPS

THE CARD SCHOOL

IAN SILVESTER ARPS

Ian Silvester ARPS: This picture was
taken in a remote village in North East
China in October 2009. I was on a trip to
photograph a narrow gauge railway
system from Huanan to Hongguang
where there is a coal mine. The coal is
mined and transported to Huanan and
then on to Harbin to the head office of
the Forestry Railway. Unfortunately all 5
locomotives had broken down at each
end of the line and it is forbidden to go
past the village of Lixin. We decided to
wait here and walk around the village. It
is only accessible by walking in winter,
and by motorbike and horse drawn cart

the remainder of the year. I discovered
these men whiling away the time by
chain smoking and playing cards. They
paid no attention to me taking pictures
for 30 minutes! I tried to capture the
atmosphere of the situation.

I will take some prints for them on my
return this November.
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RIBBON WINNER. JUDGE: DAVE YATES

Ribbon winner. Judge: Dave Yates

Dave Yates: I awarded one of my
personal ribbons to ‘Kiss’ because I felt
that it has a very strong composition,
with good quality and a surreal feel to it.
Reg J Law LRPS: The Kiss is one of a
series of shots I took of Lola Lamore
performing at a wartime re-enactment
event at the Severn Valley Railway. I first
spotted her face in the crowd. At the time
I had no idea who she was but knew that
she would make a fabulous subject for

22

KISS

REG J LAW LRPS

the camera. It was later in the day when I
realised that she is a very talented singer
and performer, very animated and
expressive and full of fun. It was this
side of her nature that I aimed to put
over. The kiss expression on her face was
a fleeting one which I was lucky enough
to capture. Perhaps some of the
atmosphere that I felt at the time comes
over in the image to the viewer. Post-
production consisted of cropping and

colour enhancement. I also applied some
softening on a layer and the used a layer
mask to bring back various level of
sharpness to the eyes, facial features and
the hat.
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MARGARET SALISBURY FRPS

Ribbon winner. Judge: Dave Yates

Dave Yates: My other personal ribbon
went to ‘Three Generations’, which
again, | felt had an extremely strong
composition and the author has taken a
wonderful opportunity to take the image
in what appears to be an un-staged
situation.

Margaret Salisbury FRPS: Attending a
Funeral, which is as much a celebration
of the life of the deceased, as a sad
parting of a loved one, gave me the
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RIBBON WINNER. JUDGE: DAVE YATES

THREE GENERATIONS

opportunity to take many images of the
people and traditions in a Ghanaian
Village. This image, my personal
favourite, of the child, her mother and
grandmother was taken when they were
absorbed in the ceremony and like all my
pictures was not posed in any way. [ was
captivated by the sad expression on the
child’s face and by the concentration and
serious expressions of the older ladies
and the way the faces “overlapped”

linking the three generations. It is an
exciting and wonderful feeling to press
the shutter believing you have “captured
a moment in time and a precious
memory of an amazing experience” and
it is this feeling which is the reason I
still take pictures with the same
enthusiasm as when I first took up
photography more than thirty five years
ago.
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RIBBON WINNER. JUDGE: NICK SCOTT FRPS

TERMINAL VELOCITY

Ribbon winner. Judge: Nick Scott FRPS

Robert Albright FRPS: The
speedometer stuck at 90 MPH, the car
going nowhere - are we in a post-
Einstein world where matter and space
and time are so closely related that we
cannot differentiate one from the other?
The green textures impacting on the
windscreen are transmuted to gold and
brown in the side-window and on the
car’s instruments and driving controls.
The photographer, or rather his post-
production assistant, is taking us on a
journey of dreams where nothing is real,
yet all is reality. The reality lies in the
skill, the dream lies in the imagination of
the creator.
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CLIVE HAYNES FRPS

Clive Haynes FRPS: The picture was
shot in the ‘Teatro-Museo Dali*
(Salvador Dali Gallery/Museum) in
Figueres, northern Spain. The whole
museum is a beautiful, incredible and
riotous creative festival of the Dali’s
surrealistic work. One of the pieces
‘Rainy Cadillac’, is complete with a
gaunt-looking driver, foliage growing in
the cab and an internal sprinkler system!
In the gloom of the rear seat sits
Salvador with his wife, Gala.

I was enthused by the surrounding
surrealism and couldn’t resist the strong
pull to treat the image in some way. |
used a combination of Photoshop layers

plus a couple of Topaz plug-ins and a
touch of ‘Fractalius’ to construct the
image I had pre-visualised. The car was,
of course, stationary, so using a ‘virtual
accelerator’ I adjusted the speedometer
to provide a better indication of speed.
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Ribbon winner. Judge: Nick Scott FRPS

Robert Albright FRPS: Spanners twirl
into a shape resembling a fossil chanced
upon in the rocks of the Jurassic Coast.
The formation is one of engineered
construction, yet flattened into one
dimension. The parallel with the
stratigraphy of marine sediments is
further explored by the spanners reaching
out like the arms of an ancient organic
form. The nuts which it seeks to grasp
twirl out of the frame in their bid for
freedom. Colours are simplified into red
and blue, only the green of life is missing
from the photographer’s palette. So,
without life, the object dies back into the
rock from which it emerged.
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RIBBON WINNER. JUDGE: NICK SCOTT FRPS

LOOSE NUTS

ANN M COLE LRPS

Ann M Cole LRPS: It’s always a
challenge, I find, to maximise what few
creative juices I have, to produce a
satisfying image that is a bit different. As
a slide worker, I have long been
interested in Still Life. Photoshop, with
its plethora of alternative techniques, has
expanded the possibilities immeasurably.
For this shot, I wanted a sharp impact in
keeping with the objects. I started by
scanning one spanner and one nut on a
flat-bed scanner. The spiral technique
was taken from a Tony Healy ARPS
article. I felt the blue tone, via
hue/saturation, on the contrasting
background had impact. Resizing and

positioning the nuts took hours of "put
and take"! The metallic border seemed
in keeping. I wasn't then into masks so I
laboriously deleted bits of the frame to
make some of the nuts appear above.
The picture has done well locally, but it
is pleasing, if surprising, to succeed in
the wider world.
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OTHER ACCEPTED IMAGES

Summer Days, Martin Addison FRPS Purple Passage, Martin Addison FRPS
Smoke Colours, Martin Addison FRPS Man Deserves a Drink, Maureen Albright ARPS
Eilean Donan Castle, Michael Arnison LRPS Flower, Frazer Ashford ARPS
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Easy Rider, P Bartlett LRPS

Filament, lan Bateman FRPS

Lamb of God, Brian Beaney FRPS

RPS DIGIT Magazine Autumn 2010

Great Oyster Bay, P Bartlett LRPS

The Scoop, lan Bateman FRPS

Agamemnon, Brian Beaney FRPS
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OTHER ACCEPTED IMAGES

Dusty Ride, Dr John Bishop Not in Service, T Bowett FRPS
No Communication., R P Bracher ARPS Giants of Steam, Brian Burrows
Boats in the Harbour, Jenny Byram Ballerina in Flight, Dr William I Campbell ARPS
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Now This won't Hurt, Ann M Cole LRPS

Driving Rain, Gerry Coles ARPS

National Squash Final (Wilstrop v Matthews)2010, Stephanie Cook
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Chasing the Bird, Gerry Coles ARPS

Love is, Gerry Coles ARPS

Restricted Vision, Stephanie Cook LRPS
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OTHER ACCEPTED IMAGES

A Day off School, Prof Brian Cooke ARPS A Winter's Walk in Rothamsted Park, Prof Brian Cooke ARPS
A Man and A Tree, Dr David F Cooke ARPS The Pier, Dr Ria Mishaal Cooke ARPS
Carnival Time, Paula Davies FRPS Three Clownfishes With Closed Sea Anemone, Len Deeley FRPS
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A Break In The Clouds, Len Deeley FRPS

Harmony, P H S Drake FRPS

Coral Tree, Madeira, Melvyn Frewin LRPS
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Diver With Soft Corals, Len Deeley FRPS

Pair of Goldfinches, Brian Eacock ARPS

Seascape, Pat Frewin LRPS
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OTHER ACCEPTED IMAGES

Solitude, Pat Frewin LRPS Battle of Britain Anniversary, Ron Gafney LRPS
Fun at the Fair, Ron Gafney LRPS Wingwalker, Ron Gafney LRPS
By the Lake, Peter Gawthrop ARPS Storm Force 10, Godfray Guilbert

32 RPS DIGIT Magazine Autumn 2010



Catch me!,Godfray Guilbert

Fungi Sporring, George A Hodlin ARPS

The Heath, Roger K Holman ARPS
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The Shipwreck, Dennis Hancock LRPS

Kimmeridge, Roger K Holman ARPS

Twins - the Same but Different, Paul Johnson
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OTHER ACCEPTED IMAGES

Father and Child, Roy C King ARPS Underground, Roy C King ARPS
Every Which Way, Malcolm Kitto ARPS Tranquillity on the Estuary, J D Lacey ARPS
Through the Mask, Eddy Lane ARPS Arctic Berg, Pam Lane ARPS
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Street Ablutions Kolkata, Pam Lane ARPS

Looking Back, Carole A Lewis ARPS

Harley Man, John Long ARPS
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Coyote Hunting by the Firehole River, Carole A Lewis ARPS

Sheep may Safely Graze, D Lewis ARPS

On the Steps, John Long ARPS
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OTHER ACCEPTED IMAGES

Alberta Winter, Malcolm McBeath ARPS Parting Company, Malcolm McBeath ARPS
Starling Murmuration with Sheep, S B Paul McCullagh ARPS Ice Forms, Ian McIntosh LRPS
Communication, Keith Mercer LRPS Ride into The Unknown, Keith Mercer LRPS
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Steve, Harry S Miller LRPS

Lyme Regis Cobb, Jerry Mitchell LRPS

White Walls, Roger Norton LRPS
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Twister, Harry S Miller LRPS

Evening Light,Vitaleta, Dr Ruth Nicholls LRPS

Marmot Dream or Nightmare, Geoff Noxon
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OTHER ACCEPTED IMAGES

Out of this World, Geoff Noxon Three Cool Bottles, Geoff Noxon
Window and Stairs, David G Pearson LRPS Marbled White (Melanargia Galathea), Paul Radden LRPS
Walking the Dog, Paul Radden LRPS Orchestral Rehearsal, Peter J Rawson ARPS
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Bamburgh Castle, Peter J Read LRPS

Swirling Dahlia, Sheila M Read FRPS

Apple Blossom Time, Jill P Reynolds ARPS
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Inverted Seed Head, Sheila M Read FRPS

Dancing Feet, Elizabeth Restall LRPS

Fading Peony, Jill P Reynolds ARPS
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OTHER ACCEPTED IMAGES

1 Will Play You a New Song, Dr Gwynn Robinson FRPS Play Net, Margaret Salisbury FRPS
Silver Washed Fritilary, John Scotten ARPS Yang Hanqui, Fiona Senior FRPS
South Shore Vancouver Panorama, Brian A Sewell ARPS Knysna Bridge, lan Silvester ARPS
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Zhalai Nuer Shed, Ian Silvester ARPS

Dawn Fisherman, George Steele LRPS

Californian Poppies, Dee Wareham
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Old House New Bike, Patsy Southwell ARPS

Agrion Splendens,Male, Monique Vanstone LRPS

Pot Pourri, Dee Wareham
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OTHER ACCEPTED IMAGES

Industrial Emissions, John Wigmore FRPS

Not Frying Tonight, Dr lan Wilson ARPS
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Tantalizing Tulip, John Wigmore FRPS
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Big Stuff — Yellow Shift.

DR GWYNN ROBINSON FRPS

THE BEST ADVICE I
COULDN’T GIVE

Well, it’s that time of year again and Tinsel Adams focuses our minds on the
10 really important issues or ‘the 10 real rules’ of photography. Here he gives
us the benefits of his many years. Wisdom not easily ignored. But first we
have a ‘forward’ from the great man himself.

ver since my first exposure to
Ephotography with a pinhole

camera right through to my
present grand (and well deserved) status,
I have watched it all develop and become
mostly Japanese. English light seems
well suited to Japanese equipment but I
cannot help but think that our big
industrial base should have risen to the
challenge. I remember our motorcycle
industry. But I digress. I enjoyed it all so
I suggest that you do the same. I have
written down the 10 best lessons I have
learned from my many years of
significance for you to appreciate.
Signed: Tinsel
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1 Photography is all about the
equipment. This goes without saying
even though I did actually bother to say
it. If we look at all the advertising,
reviews, books, paparazzi, and my
cupboard, then the truth is obvious. Big
cameras produce the best results.
Besides, photographers need to be taken
seriously which just doesn’t happen if we
use small equipment. Imagine the
embarrassment of being seen using your
mobile phone as a camera!

We need back up equipment too. So
that’s at least double the credibility. It is
obvious that you are a better
photographer as you have thought about

the amount of equipment.

2 Big Lenses are better

If it costs more it will be better. Why
even think about it, just hand over your
money and add the big lens to the
equipment pile in the knowledge that
your photography will just have
improved. And don’t forget the lens
hoods. They make your lens (and you)
look even more impressive. Get the
biggest that you can.

3 The More Megapixels the better
Have you ever seen an image with just a
few thousand pixels? They’re rubbish.
1Mp, better. 4Mp good. 8Mp Excellent.
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DR GWYNN ROBINSON FRPS

Enormously Red Monument

The trend is not an accident but a stark
fact. Look for the big number. Besides
more megapixels take up more room
which means bigger camera equipment
which makes us better photographers.
Even though you have a camera with a
huge number of pixels, being the expert
that you are you can impress your friends
and get more images onto your memory
card than others. How is this possible?
Simply take darker photographs to give
you more images per memory card. This
is a secret that the Pros keep to
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themselves. It’s nothing to do with
avoiding burnt out highlights as they
would have you believe, but more to do
with getting that extra great shot on the
card. How so? Well it’s all to do with
mathematics which is way beyond mere
amateur photographers. But here I will
lay it all out in the open for you.

Pixels record light as a number. Smaller
numbers represent darker light and
bigger numbers represent brighter light.
Smaller numbers take up less space (to
prove this for yourself write down a

small number next to a bigger one —
which takes up less space?). So you can
get more darker pictures onto each
memory card, so you won’t miss that
great shot changing memory cards as so
often happens.

4 Tripods are a waste of time and
money

And they get in the way! You can’t
normally use them for sports, fast action,
portraits or fashion and they look so un-
cool. You can’t use them in museums,
art galleries, Banks, police stations,
courts or prisons.

But this misses the point. We must
remember that the more equipment we
have the better we are as photographers.
So there is a strong argument for having
the biggest, heaviest tripod that you can.
My wife carries my ‘Womanfrotto’
everywhere so I am never without
credibility.

5 The only way to be creative in
photography is to use Photoshop

We all know that traditional photography
is just a record of what is there so it is
about as creative as a damp cloth.
Everyone has Photoshop for a reason -
to create those pure, genuine, original,
stunning shots. We all know that
creativity is something that only happens
in Photoshop. But far more importantly,
you can’t use Photoshop without a
computer, screen, hard drive, keyboard,
mouse, etc, ie lots more equipment. Your
prowess as a photographer depends upon
the best computer equipment you can
buy.

Better still if you can grab a room twice
the size of the old dark room and fill it
with your camera related computer stuff.
Your expertise as a photographer
depends upon not only on having tons of
equipment but far more importantly
everyone else knowing that you have it.
Dark rooms just didn’t cut it. Computer
rooms make it all visible to everyone.
Some of the best photographers also buy
dedicated computer desks to show and
display their computer equipment,
massive comfy manager chairs, huge
book cases, gallons of programs, and on
and on. Once you get into computers
your potential becomes almost endless.
It is worth considering more computer
equipment if you feel that you want to
move on and improve your photography.
As an added bonus it’s worth getting that
latest version of Photoshop (or at least
an icon for it on your desktop) to show
your friends that you take photography
seriously.
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Camouflage (except for that great big yellow beak)

6 Composition is for wimps

Oh how true. Is your heart divided into
thirds? Do you look at everything so that
it has a lead in or is on a diagonal? Ever
restricted yourself to an odd number in
the pub or at a restaurant because it is
better? Of course not, so why do it in the
viewfinder? It’s all a big myth set out by
the film buffs. They’re just trying to
confuse you.

But hang on, what has this to do with
equipment or to do with being a good
photographer? Consider how we
compose an image. We use a viewfinder
or an LCD screen and it follows that the
bigger the screen the more you will be
respected as a photographer. A bigger
screen can only be accommodated on
bigger camera bodies. So again it all
comes down to bigger, better equipment.
Good composition comes from having
the biggest camera LCD screen possible,
even though with lots of megapixels we
don’t actually need to compose as we can
crop the real picture out of it all later on.
7 Manual mode means taking control
No it doesn’t. Manual mode means
getting confused and constantly having to
fiddle with things and missing shots,
rather than enjoying the experience and
showing everyone that you are as good a
photographer as you know you are with
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Its Murder on the Dance Floor (which is why we re up here)
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DR GWYNN ROBINSON FRPS

At The Speed of Light

all of that expensive equipment. Auto
mode is there for a reason, because that’s
the one that works.

But we need to remember that only the
biggest and best equipment has a
dedicated manual mode setting. Real
photographers don’t hide the camera’s
abilities. We need to make sure our
camera has ‘that’ dial and we need to
show everyone that we take real control
by purposefully selecting auto mode.
Go for a camera with the most
buttons/dials. They take up space which
means that the camera will have to be
big, noticeable and obviously will take
great pictures.
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8 Shutter speed is important

What speed does light travel at? Yes, the
speed of light. So how can the shutter
ever affect it? Complete nonsense. In fact
I often wonder why there is a dial to
change the shutter speed at all. It’s
probably there to pacify the sales guys
and to fool the novices. I suspect the
graphic designers, who all like
symmetry, wanted another dial/button to
balance the manual mode one. Never-
the-less these dials only come with the
big, expensive cameras for the real
photographers. So when you are out
buying your next camera, look for one
with some shutter speed.

Be careful that your chosen camera
doesn’t have too much shutter speed
(ask the assistant) as the earth’s rotation
could affect your images, blurring them
badly if the shutter speed is too long.

9 Envy is beneath us. We are way
better.

The fact that astronomers have really big
‘lenses’ and ‘cameras’ does not give
them credibility, quite the reverse.

What do they photograph? Dust. Dust
that is millions of miles away. Well how
dull is that! When was the last time you
saw a really good photograph of dust?
Their equipment is so large that they
cannot take it to parties or events so the
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Some Say... Happy Christmas

best they can do is talk about their stuff.
Talk is dull. We all know that actions
speak louder than words so we
photographers have a real advantage. We
carry our credibility with us. We do not
need to be envious of overly large,
impractical equipment. People can see
how good we are from the equipment
that we carry with us.

10 Photography is to be enjoyed

It is so important to enjoy it all. This will
lead you to buy more, bigger and
expensive equipment, which will make
you a better photographer, which in turn
will make you happier.

What can be better than setting up your
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massive 500mm F2.8 lens on your
Medium Format leaf camera held
together with that shiny aluminium (and
carbon fibre) heavy tripod, whilst you sit
along side on your extra comfy seat with
a champagne glass full waiting for that
special moment.

Yes, real photographers take their time
at a location so that the shots come to
them and people have enough time to
notice how good they are. But to make
our skills complete we need to add one
extra piece of expensive equipment, a
remote control, so that we can show
how expert we are by capturing that shot
while we relax in total comfort.

Now, where’s that book on brain
surgery. I’ve an ‘op to do early next
week so I need to find out what shiny
equipment I need to become an expert.
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